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VCell BioModel using the Moving Boundary Solver

Objective

Create a simple Biomodel of a fluorescence photobleaching (FRAP)  experiment in 
a moving cell; learn how to specify kinematics in a VCell Biomodel and utilize the 
Moving Boundary solver.

Goals

• Create a Biomodel Physiology that recreates a fluoresence photobleaching
experiment and a spatial deterministic application of the Physiology using a 
2D geometry created from analytic expressions for a simple circle

• Specify kinematics (i.e. velocities) of structures and the molecules contained 
within the structures

• Define initial conditions that vary in x and y using Boolean expressions.

• Create a simulation using the VCell Moving Boundary solver, specifying time 
course and computational mesh.

• Run the simulation, view and export results.



Notes on the VCell Moving Boundary Solver

Moving Boundary Applications in VCell allow for PDE (spatial) simulations to occur within a 
geometry where the boundaries of compartments can change in shape and position 
within the overall computational space.   There are some important things to keep in mind 
when you create this type of application.

• The current implementation of the moving boundary solver only works with 2D geometries.  We 
hope in the future to enable problems with 3D geometries.

• Creating an application with a moving boundary solver follows the same steps used for fixed 
domains, except that a velocity is assigned to points on the cell membrane (and optionally for 
species residing with the volume) by defining Kinematics for surface and volume objects as part of 
the description of the Geometry.

• Species will have both diffusion terms (which can be 0) and velocity terms defined by the 
kinematics.  Because displacement  terms will be different in different compartments, species in 
different compartments will not necessarily move together.  This tutorial provides an example of 
different types of kinematics for membranes and volumes.

• Currently, VCell tools for analyzing spatial results are not available for results of moving boundary 
simulations, so it is necessary to export your results to other image processing software to 
analyze the results of simulations.
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Your first time opening VCell

You need to register as a New User if 
you want to run simulations on the 
VCell compute resources, or use the 
VCell database to store models that 
can be shared with collaborators.
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Your first time opening VCell
Guest Login Option
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BioModel
Physiological representation of the model 
where the compartments, molecules, 
biochemical reactions and kinetic parameters 
are defined.

Applications
There may be one or multiple applications 
within one BioModel. Here, simulation-
dependent conditions are defined, such as 
initial conditions, simulation specific details, 
and changes in kinetic parameters. 

Simulations
Execution of BioModel Application with 
defined length of time, time step, 
resolution, solver and parameter 
overrides. 

VCell BioModel Organization



ContentsMoving Boundary Solver tutorial

The VCell Interface
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An extensive, searchable, help guide 
is available from the Help Menu
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To create a new VCell model, click “File” > “New” > “BioModel”
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Tip: “Save as Local” saves a VCML file to the local machine, and 
can be used if you are disconnected from the server when 
building a model

To save your model, navigate to “File” and make your 
selection from the four “Save” options that are 
available. 
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To re-open a model, navigate to the folder that the 
model was saved in and double-click the model name.

Tip: When click on a model in the database window, 
Annotations about the model appear in the properties pane 
here.
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To create a new membrane, click on 
one of the black lines so they turn 
green, and select “Add Membrane”.

To create the components to your model, start with creating 
a volumetric compartment by selecting the Structure Tool. 
This will automatically create  your first compartment.
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To create a new compartment, click on the 
dotted black lines, which will become green,  
and select “Add Compartment”.
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If you need to rearrange compartments and 
membranes, or any other features, use the selection 
tool and drag them by their label.

Your model  requires 2 volumetric compartments separated by a 
membrane compartment. 
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Use the selection tool to name compartments and membranes. The 
area will turn red upon selection. Double click the structure name 
you wish to change and enter the new name.
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You can also change the Structure Name on the 
Object Properties tab.
You can annotate compartments and rename 
species here as well. 

The volume compartments in this tutorial are EC 
and Cyt, separated by a membrane, PM
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Use the Annotations tab in the Properties pane 
to add either unique identifiers or text 
annotations for any model component.
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To add a species to the model, click 
on the species tool, then click in 
the area you want to place the 
species.

Species – are molecules, 
compounds or states thereof.
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This tutorial uses only a single diffusing species 
(“Dex” for fluorescently labelled dextran) that 
will be photobleached in a moving cell.

Look at other tutorials to see how to create 
reactions among species.
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To remove a species or reaction from your model, 
select the species or reaction and click on either the 
“Delete” button or the backspace button on your 
keyboard.

Note that you cannot move species, reactions, or fluxes from one compartment to another.  You must delete a 
species, flux, or reaction from one compartment and then create it in another compartment.
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To create an “Application”, select Application 
and then right click and  select “New 
Application” > Deterministic, Stochastic, or 
Network-Free.

To use the moving boundary solver, create a Deterministic 
Application.

Alternatively, select New Application from the 
drop down menu and choose from 
Deterministic, Stochastic, or Network-Free.
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Double click on the name box and rename the 
application as “FRAP”. Press “Enter” on your 
keyboard to finalize.
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Once you have created an “Application”, expand the submenu and 
select the Application you are working with. When an “Application” 
is selected, the “Geometry Definition” tab will be accessible.  From 
there, navigate to “Add Geometry” and create a “New” geometry.
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Click “Analytic Equations (2D)” > “OK”.

Note: Only 2D geometries can be used with the current Moving 
Boundary solver.  The solver cannot be used with 3D geometries.
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Double click in the domain name to change the name to “EC” and 
then use Enter to finalize
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Select “Add Subdomain” > “Analytic”.
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Select Circle from the drop-down menu for the Shape and enter 
0,0 for the Center Point and 5 for the radius.  This will create a 
circle10 µm in diameter centered on x = 0, y = 0 in the domain.  
Select “New SubDomain to add to your geometry domain

Note: You can also use the 
Copy Expression function if 
you have already created a 
subdomain, or simply write 
the expression in the domain 
specification

Note: Use the up/down arrows to expand the view of 
the geometry to better visualize the subdomains
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Double click the Name for the new domain and rename as “Cyt”.  
Use Enter to finalize the new name.

You will notice that the new Subdomain (shown in brown) is not centered and 
takes up most of the entire computational domain (defined by default as a 10µm 
square).  You will next use the Edit Domain function to adjust the size of the 
computational domain.
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, 

Note: Because the  Cyt subdomain is a circle centered at 0.0 in the domain, the circle 
will start at the left edge of the domain, giving it room to move across the domain 
during the simulation.

Select “Edit Domain” to adjust the overall size of the computational domain.  For this tutorial, the extent of 
the domain should be 20 um in x and y, and place the origin at -6 in X and -10 in y.  
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The geometry now defines a circular “Cyt” domain at the left 
boundary of a square “EC” domain.  Next we will define the 
motion of the subdomain within the geometry.
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Select the “Kinematics” Tab in the Geometry workspace
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In the Spatial Process window, select “New”> “new Surface Kinematics.”
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Click on the Spatial Process to select that process

Write in an expression to define the velocity in x and y.  For this example, x is a constant velocity of 4 
µm/s.  Velocity in y is described as a sine function that varies with time (5*sin(10*t) µm/s, so the 
object will move up and down as well as to the right during the simulation.
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In the Spatial Process window, select “New”> “new Volume Kinematics.”
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The software by default will create volume spatial processes in the order of volumes 
shown in the top spatial volume table.  Continue to create new processes until you create 
a process for the volume object you want; in this case, the vobj_Cyt1 (cytosol).  Select the 
process you do not want, and “Delete Selected”
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Enable the Interior Velocity using the check box in the Object Properties Window

When a  new Spatial Process for a volume object is created, an error  is created 
associated with the Spatial Object because it has not been enabled to have an Interior 
Velocity.  You must go back and select that Spatial Object.
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Click on the Volume Process to select that process.

In this example the cytosol will move with the membrane, so the same functions are used to describe 
the x and y velocities
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On the Geometry tab > Structure Mapping tab, use the line tool to link 
the physiology to the geometry. You must select the line tool each time 
and drag your cursor from a structure to its corresponding subdomain.
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Select “Specifications” to define the initial distribution of dex.  Type the Boolean expression shown 
either by replacing the text directly in the Initial Condition box, or type in the “Expression” box in 
the properties pane below.  

Note: A Boolean expression evaluates as 1.0 when true and 0 when false.  The 
expression defines the concentration of dex as 10 µM when x is less than -2.5 OR 
greater than 2.5, OR when y is less than -2.5  OR when y is greater than 2.5); otherwise, 
the value is 0.   
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Use the default value of 10.0 µm2/s for the Diffusion Constant for Dex
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Click on the “Simulations” tab 
and then the New Simulation 
icon to create a simulation. 

To edit the simulation, click the Edit Simulation 
icon to access the Edit Simulation Dialog.

Note: You can create many different simulations from a single Application, varying the 
length of time, spatial resolution, parameter values, solvers, etc.

Go to the Simulations page. 
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Click the “Parameters” tab to view or 
edit the parameters (e.g. rate constants 
or initial concentrations in the model). In 
this tutorial you can leave the 
parameters as initially described.

The Edit Simulation Dialog has 3 tabs.  The 
Parameters Tab is used to adjust parameters for 
each simulation, or to scan multiple parameters.  
Use the Default settings for this tutorial
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Use “Lock aspect ratio” to keep 
the values proportional.

Select the “Mesh” tab to edit the mesh resolution for the simulation in the X 
and Y planes.  Select “OK” to accept any changes. 

The larger the total size of the mesh  
elements the more accurate the solution, 
but the simulation will be slower. 

Note: Use the smaller mesh size values shown here for the tutorial, or the simulation 
will take a long time to run.
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Select the “Solver” tab to configure solver-
specific options. Use “OK” to accept text changes. 

The Moving Boundary solver is 
selected by default whenever 
kinematics are defined

Change the Minimum and 
Maximum time steps

Change the Output options

Note: The solver computes the appropriate time step at each point; the output option 
only chooses which points you choose to save.  Selecting a particular interval will 
ensure the solver uses those specific times in the computation.
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You may receive a warning regarding the 
size of your simulation. You should 
select “OK” and run the simulation.
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Select the simulation you want to run, then click the green “run” arrow to save 
the model to the database and run the simulation on the remote servers at 
VCell.  Your simulation results will be saved in the database.



ContentsMoving Boundary Solver tutorial

To view the status of the simulation, look under the “Running Status” 
column. 

Use the  “View Results button to see the simulation results.

Note: You can view results any time the Results tab says “yes”, even before the 
simulation is 100% complete.
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Select the Time Point using the slider.  

Select the range for the BlueRed or Gray color map.  
By default it is automatically set to the Max and Min 
at that time point

Select the Variable to view

Note: Unclick “ Auto range” and set the values in the Max and Min boxes to enforce a 
constant range for the entire time course.
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Note: The data Range (Min-Max) had 
Auto range selected for these images, so 
the color scale is different at each time 
point.
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Use the “Export Data” functions to help analyze the results.  From the drop down menu of 
export formats, select either “HDF5 files” or “Nearly Raw Raster Data (nrrd)” to output a 
time sequence of the concentration data as floating point values.  



ContentsMoving Boundary Solver tutorial

Select the Species to export (there is only one in this model).
Select the Time Interval to Export

To export as HDF5 files:
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Selecting “Start Export” will bring up a HDF5 settings window.  
Use the default settings and select “OK” 
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Select the Species to export (there is only one in this model).
Select the Time Interval to Export

To export as HDF5 files:
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Click “Start Export” and an additional dialog box appears with NRRD specific options.  Use 
the selections shown here, there press “OK”

Export jobs are saved to the server; when the job is 
complete you are prompted to save a local file.
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HDF5 and NRRD files can be opened and analyzed in a variety of imaging processing 
software including FIJI/ImageJ.  
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You can also export a Quicktime movie for presentations.  
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Right click on the FRAP application from the navigation window 
and select “Copy” to copy the original FRAP application.

Let's create a second Application to change the parameters for both the kinematics and 
diffusion coefficient and see how that affects the spatial distribution of the fluorescent probe
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Right click on the Copy of FRAP application and select “Rename” 
to copy the original FRAP application.
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We can call the new Application “Modified FRAP”.  You need to 
use the enter key to accept the new name.
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Return to the Geometry > Kinematics tab

Select the “Surface Normal” check box to enable a kinematic process to apply to the normal to the 
surface.

Select the surface object sobj_Cyt1_EC0
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The expression for the surface velocity will move the normal to the surface in both x and y, thus 
causing the membrane to contract and expand; overall x will have a constant velocity of 4 µm/s.

Select the Spatial Process for the surface object sobj_Cyt1_EC0 so the surface velocity 
properties appear in the bottom window.

Change the expression for the surface velocity for x to (( - 5.0 * sobj_Cyt1_EC0_normalX * sin((20.0 * 
t))) + 4.0).  Change the expression for the surface velocity for y to ( - 5.0 * sobj_Cyt1_EC0_normalY * 
sin((20.0 * t)))
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For this demonstration, the diffusion constant is for a large, slowly diffusing species.  The simulation 
results will show what happens to a slowly diffusing volume species when the membrane contracts 
rapidly.

Go to the Specifications tab and change the Diffusion Constant to 1.0.  Double click in the box 
to edit.
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Go to the Simulations tab.  The simulation will have been copied along with the application, but 
not run.  There is no need to edit the simulation parameters, and you can simply run by 
selecting the green arrow to run remotely on VCell servers.
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Once Running Status indicates there are results, select the simulation and use the graph icon 
button to open the results viewer
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Use the Time slider to see  what happens 
during the simulation.  
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The velocity of the membrane contraction is sufficiently fast 
that the volume species becomes concentrated under the 
membrane before the concentration gradient can be
dispersed by diffusion. When the membrane expands, there 
is a low concentration of dex under the membrane as it 
diffuses into the newly created volume.

Note that autorange is selected for each image.

t = 0.04 s

t = 0.16 s

t = 0.26 s

t = 0.46 s


